
Using Technology  
to Administer Provincial 
Assessments

Examination Administration, Alberta Education

ALBERTA EDUCATION



Using Technology to Administer Provincial Assessments 

Distribution: This document is posted on the Alberta Education Website. 

© Copyright 2023, the Crown in Right of Alberta, as represented by the Minister of Education, Alberta Education, Provincial Assessment, 
44 Capital Boulevard, 10044 108 Street NW, Edmonton, Alberta T5J 5E6, and its licensors. All rights reserved.  

Special permission is granted to Alberta educators only to reproduce this document for educational purposes and on a non-profit basis.  

Excerpted material in this document shall not be reproduced without the written permission of the original publisher (see credits, where 
applicable). 

https://www.alberta.ca/administering-diploma-exams.aspx


Using Technology to Administer Provincial Assessments | Alberta Education, Provincial Assessment  

 

Contents 

Using Technology to Administer Provincial Assessments ................................ 1 
• Acknowledgements 1 
• Overview 1 
• General Guidelines 1 
Options for Using Technology to Administer Provincial Assessments ............ 2 

• *NEW Alberta Education Digital Exam Platform 3 
• Microsoft Word 3 
• Google Docs 3 
• Learning Management Systems 3 

Options for Accommodations ............................................................................... 4 
• Chrome Dictation and Select-to-Speak 4 

• To Enable Dictation 4 
• To Enable Select-to-Speak 6 

• Enabling French Language 2 
Appendix: Sample Secure Google Exam Configuration for Chromebooks ...... 3 
• STEP 1: Create Exam Organizational Unit (OU) and User Settings 3 
• STEP 2: Create Exam Template 4 
• STEP 3: Create Exam Users and Apply to Exam OU 5 
• STEP 4: Set Up Native Printing 5 
• STEP 5: Set up GAM to backup exams, delete all files and trash & reset  5 
• STEP 6: Add a Custom App to block the Research Pane 6 
Contact Alberta Education .................................................................................... 7 
 

 

 

  

 



Using Technology to Administer Provincial Assessments | Alberta Education, Provincial Assessment  1 

 

Using Technology to Administer Provincial Assessments 

Acknowledgements 
In response to feedback from school authorities, Alberta Education’s Exam Administration Branch and Technology Leadership 
Branch co-hosted a focus group on March 2, 2016, to discuss alternative approaches for administering the Part A Written 
Response portion of Provincial Achievement Tests and Diploma Exams digitally in Chromebook environments. In attendance 
were representatives from Chinook’s Edge, Wildrose, Red Deer Public, Edmonton Public, Calgary Catholic and Buffalo Trail. 
These school authorities were instrumental in developing an example of a clear process that Alberta school authorities can 
use to ensure that students can securely use Chromebooks to write both Provincial Achievement Tests and Diploma Exams. 

Alberta Education would like to express its appreciation to Myles Doupe from Chinook’s Edge School Division, who stepped 
forward to find a solution to an outstanding issue in the process that was developed. Myles wrote an extension to Chrome to 
resolve the issue.  

Alberta Education would like to thank the Jurisdictional Technology Contacts and each of the school authorities that 
participated in this collaborative effort.  We will continue to explore effective ways to use technology to write provincial 
assessments and look forward to further opportunities to work together to best meet the needs of our students.  This document 
will continue to evolve over time and additional examples will be added as appropriate.   

 

Overview 
Alberta Education is committed to supporting school authorities to administer provincial assessments using technology so 
students have every opportunity to succeed. Currently, Provincial Achievement Tests and diploma exams can be administered 
using technology. The purpose of this document is to provide examples that can be used to assist schools and school 
authorities with IT decisions given their unique local environments (i.e. computing platform, type and number of devices, exam 
administration requirements, etc.). 

It should be noted that, for examples presented in this document, exam security is achieved through a combination of various 
technical measures as well as vigilant proctoring. While most technical options currently make it possible to adhere to 
provincial exam rules and directives, it cannot be assumed that network configurations and account permissions can eliminate 
the need for human supervision. It is important to keep in mind that for pencil and paper exams, direct student supervision is 
still the primary security measure. For that reason, in the absence of technical measures, vigilant proctoring in and of itself is 
still an acceptable alternative.  

General Guidelines 
Any solution that would enable students to use technology for written response provincial assessments must incorporate these 
functions. 

• Students can respond to up to 3 written response questions. 
• Students can access all permitted word processing tools including: a text editor which supports formatting, including 

either rich text or html editors; spell check in Canadian English and French. 
• Functions that are not permitted, such as autocorrect, predictive word search, and translation must be disabled. 
• In the event of a device or power failure, student responses must be saved in a way that is recoverable by exam 

supervisors. However, students cannot be permitted to save their responses to locations that can be accessed after 
the exam administration.    

• Students cannot use functionality that would contravene exam administration rules, such as Internet access, sharing 
documents, communicating with others, online queries, and accessing previously saved work.   

• At any time during the exam administration, either the student or supervisor can print student responses. 
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Options for Using Technology to Administer Provincial 
Assessments 
 
 

 

 

 

 



Using Technology to Administer Provincial Assessments | Alberta Education, Provincial Assessment  3 

*NEW Alberta Education Digital Assessment Platform 

Quest A+ is going to be replaced by a new digital assessment platform. For this school year, it will be available for practice 
written response, PATs and humanities Part A diploma exams. Unlike other solutions presented in this document, which apply 
only to administering Part A Written Response assessments, the digital assessment platform serves multiple purposes. In 
addition to word processing, it is also used for machine-scored PATs, Diploma Exam perusals and other supporting processes 
such as practice tests and field testing of PATs and Diploma Exams.  

This platform enables secure online exam administration on both student and school-owned devices. Once a secure exam has 
begun, its associated Safe Exam Browser does not permit students to exit the test environment. Chrome OS devices can be 
securely supported through configurations made in the Google Admin Console.  

This option also provides speech-to-text and text-to-speech accommodations. 

This is the recommended option for Part A exams as it follows all exam administration rules.  

 
Microsoft Word 

Microsoft Word is a widely used tool to administer written response provincial assessments. Prior to the exam administration, 
the functionality of PC or Mac devices are configured to comply with exam administration rules and directives.  After the 
administration of the provincial assessment, school authority personnel are expected to delete all student responses from local 
servers or drives. However, the new Microsoft Word 365 contains functionality that cannot be turned off and contravenes exam 
administration rules.  

Google Docs 

Chrome OS devices are widely used in many schools.  When properly configured, school-owned Chrome OS devices and 
Google Docs can be used by students for Part A Written Response PATs and Diploma Exams.  

Since Google Docs is developed by Google, modifications to the product could be made at any time. Please ensure current 
Google doc features do not contravene exam administration rules. 

For more information on how to configure Chrome OS devices with Google Docs to administer Part A Written Response PATs 
and Diploma Exams, please see Appendix.  

Learning Management Systems 

Learning Management Systems (LMS) like Moodle and Desire2Learn often have a built-in ability to administer Part A Written 
Response assessments. An LMS can then be configured to administer these assessments securely on Chrome OS devices, 
PCs and Macs. 

Securing Chrome OS devices on an LMS 
An LMS can be secured on Chrome OS devices using Managed Guest Sessions or kiosk apps. A kiosk app for Moodle can be 
made using the document provided online. 

Securing PCs and Macs on an LMS 
An LMS can be secured on PCs and Macs through a locked browser. Several third party software providers can provide 
locked browsers including Respondus and Proctorio. Safe Exam Browser is a free locked browser provider configurable for 
any digital exam. 

 

 

 

 

 

 

http://cytochromec.net/blog/2015/05/secure-browser-for-testing-on-moodle-using-chromebooks-or-winmac/
https://www.respondus.com/
https://proctorio.com/
http://safeexambrowser.org/
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Options for Accommodations 
 

Chrome Dictation and Select-to-Speak 

To Enable Dictation                                              
• Click on the icon on the  
• Bottom right of the screen  

where the clock is,  
and a menu will pop up. 

 

 

 

 

 

 

• Click on Accessibility 
 

 

 

 

 

 

 

 

 

 

• Click on dictation 
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• To change the language of the   
dictation to French, click on  
the settings icon. 
 
 
 
 

• In the accessibility settings, select   
Keyboard and test input. 
 
 
 
 
 

 

 

 

 

 

• In Keyboard and test input, under   
Languages, click on Change. 

 

 

 

 

 

 

 

 

  

• Select the French (Canada), click Update,   
 and then Continue. 
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• A microphone icon will  
display on the bottom right 

• Click on the icon and speak  
to produce text. 

 

 

 

 

 

 

 

To Enable Select-to-Speak 

 

• Click on the round icon that  
looks like a speaker on the 
bottom right of the screen 

 

 

 

 

 

 

 

 

 

• Highlight the text you want it  
to read. It will start reading  
automatically. 
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Enabling French Language    
• Before logging into the  

Chromebook, click on  
choose Language and Keyboard, 
select French (Canada) 
for the language and Canadian  
Multilingual for the keyboard 
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Appendix: Sample Secure Google Exam Configuration for 
Chromebooks 
A special acknowledgement is extended to Buffalo Trail Public Schools Regional Division, Chinook’s Edge School Division, 
and Red Deer Public School District for contributing to the development of the following configuration. 

The following steps were created for devices within a specific school authority environment. This is provided as a helpful 
example of how Google Chromebooks can be configured to meet Provincial Achievement Test and Diploma Exam 
administration requirements.   

Additional suggestions on how to configure Google Chromebooks are welcome. Please contact Jennifer.phillips@gov.ab.ca .    

STEP 1: Create Exam Organizational Unit (OU) and User Settings 
 

• Create an OU for exam users. 
• Device Management->Chrome Management->User Settings 

o Select the OU where your Exam Users are held from the left panel. 
o Wallpaper > Upload Wallpaper > Use Secure Exam jpg 
o Avatar > Upload Avatar > Use Secure Exam Avatar jpg 
o Allowed Types of Apps > uncheck all but Extension 
o Force-installed Apps and Extensions > Google Docs, and Hide Google Docs Research,  

Accent Grid, Dictionary, Thesaurus & Reference 
o Allow or Block All Apps and Extensions - Block all apps and extensions except the ones I allow 
o Allowed Apps and Extensions > Google Docs, Hide Google Docs Research, Google Dictionary,  
o Password Manager > Never allow use of password manager 
o Screen Lock > Never automatically lock screen on idle  
o Incognito Mode > Disallow incognito mode 
o Home Button > Always show Home button 
o Homepage > Homepage is always the Homepage URL, set below 

 https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/co
py 

o Pages to Load on Startup 
 https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/co

py  
o Screenshot > Disable Screenshot 
o Cast> Do not allow users to cast 
o Pop-ups > Allow all pop-ups 
o Blocked URLst: 

 * 
 https://docs.google.com/picker/ 

https://docs.google.com/spreadsheets/d 
 https://docs.google.com/presentation/d 
 https://docs.google.com/drawings/d 
 https://docs.google.com/forms/d/ 
 https://accounts.google.com/logout 
 https://accounts.google.com/AddSession 
 https://accounts.google.com/AccountChooser 
 https://accounts.google.com/SignOutOptions 
 https://workspace.google.com/ 
 https://translate.google.com/ 
 https://drive.google.com/sharing 
  

o Must blacklist these specifically even though * is blocked. 
o Blocked URL Exceptions 

 chrome-untrusted://print/ 
 Chrome://settings/languages 
 chrome://print 
 https://drive.google.com/ 
 https://drive.google.com/drive/ 
 https://drive.google.com/drive/my-drive 

mailto:Jennifer.phillips@gov.ab.ca
https://chrome.google.com/webstore/detail/google-docs/aohghmighlieiainnegkcijnfilokake?hl=en
https://chrome.google.com/webstore/detail/hide-google-docs-research/fnifdkggkcjiaahokngjoajgpboaaojb?hl=en
https://chrome.google.com/webstore/detail/accent-grid/efedjomeallaomheefphgnbleieplnfk
https://chrome.google.com/webstore/detail/dictionary-thesaurus-refe/cljhbajmjhfhjfnebjhgdhmggdookcio
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 https://docs.google.com/document/u/0/ 
 https://goo.gl/zWFc0Z 
 goo.gl/zWFc0Z 
 https://docs.google.com/document/d 
 https://drive.google.com/drive/shared-with-me 
 https://content.googleapis.com/ 
 https://apis.google.com 
 Chrome://settings-frame/languages 
 https://google.com/static 
 https://googleusercontent.com 
 https://www.thefreedictionary.com/ 
 https://www.freethesaurus.com/ 
 https://accounts.google.com 

 
o Managed Bookmarks 

 https://drive.google.com/drive/my-drive    [Name: Exam Recovery] 
o Bookmark Bar > Enable Bookmark Bar 
o Bookmark Editing > disable bookmark editing 
o Google Translate > Never offer translation 
o Developer Tools > Never allow use of built-in developer tools 
o Form Auto-fill > Never auto-fill forms 
o DNS Pre-fetching > Never pre-fetch DNS 
o Multiple Sign-In Access > Block multiple sign-in access for users 
o Search Suggest > Never allow users to use Search Suggest 
o External Storage Devices > Disallow external storage devices 
o Audio Output > Disable audio output 

 

When the exam is finished, you can use the Google Apps Manager (GAM) command to erase any docs left in the account with 
the following command: 
 
gam user exam001(at)school.ab.ca show filelist | gam csv - gam user ~Owner delete drivefile ~alternateLink purge 
 

STEP 2: Create Exam Template 
 

 

Below is an exam template that has the ID#, current page and total pages in the footer, and is double-spaced formatted.  If 
desired, it is possible to create an alternate template by replacing the “edit” at the end of the document address with “copy” to 
force a copy on a new user.  The following link points to a Red Deer Public example (feel free to modify and use): 
https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/copy 

 
 
 
 
 
 
 
 
 
 
 

https://www.freethesaurus.com/
https://www.freethesaurus.com/
http://accounts.google.com/
https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/copy
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**This link needs to be added in the user settings as the homepage and pages to load on startup.  The added bookmark (exam 
recovery) allows the student access to the Drive if the device fails, loses power, etc. We have also added a second bookmark 
for the printing document which is listed in the printing section of this document. 
 

STEP 3: Create Exam Users and Apply to Exam OU 
• Create a new OU for all exam user accounts (Google Exams) and then separate them by school. 

• Create exam accounts using a naming protocol that identifies the school and reflects that it is an exam account (i.e., 
schoolexam001(at)school.ab.ca  

• Associate the accounts with the appropriate OU’s.  

• Create Google spreadsheets for each school with the appropriate usernames and passwords.  Teachers will be responsible 
for cutting these up and giving each student the username and password at the beginning of the exam. 

STEP 4: Set Up Native Printing 
 
We now use native printing by chromebook OU IPP queues 

STEP 5: Set up GAM to backup exams, delete all files and trash & reset passwords 
nightly 
This is an example from a school division: 

New GAM commands.  Please note this is using GAM Advanced X (GAMADV-X).  When 2500 exam accounts were run it 
finished in 33min.  Advantages of this version of GAM include: output file with any errors or failures, speed, not having to 
recreate accounts daily and the respository account is not getting “spammed” with transfer emails. 
 

gam redirect stdout Transfer.out multiprocess redirect stderr stdout csv "Example Exam Accounts MASTER - 
Examplegam.csv" gam user ~Email transfer drive google.exam.repository@school.ab.ca targetuserfoldername "#user#" 
 

gam redirect stdout ChangePW.out multiprocess redirect stderr stdout csv "Example Exam Accounts MASTER - 
Examplegam.csv" gam update user ~Email password ~PW 
 

gam redirect stdout EmptyTrash.out multiprocess redirect stderr stdout csv "Example Exam Accounts MASTER - 
Examplegam.csv" gam user ~Email empty drivetrash 
 

Please note that this is an example solution and may not be right for your environment. 
 
GAM command to copy all GDocs: 
 

gam.exe ou_and_children exam.school.ca show filelist id | gam csv - gam user ~Owner get drivefile id ~id format microsoft 
targetfolder F:\exam-backup\%DATE:~10,4%\%DATE:~4,2%\%DATE:~7,2%\~~Owner~~ 
 

The above command will create a directory structure on the drive F: that will look like: exam-
backup/<year>/<month>/<day>/GAFEUserName. Our schools assign specific exam accounts to specific students, so we’re 
able to determine which student was on which account per exam per day, in case something needs to be found. 
 

GAM command to purge: 
 

gam.exe ou_and_children exam.school.ca show filelist id | gam csv - gam user ~Owner delete drivefile ~id purge 
 

https://github.com/taers232c/GAMADV-XTD3
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This will purge the Google Drive files for ALL users under the specified OU. Replace “exam.school.ca” with whatever is 
appropriate for you. This command will recursively parse user accounts. 
 

GAM command to delete everything from trash for all users in OU strucuture: 
 

gam.exe print users Email query orgUnitPath="/exam.wrsd.ca" | gam csv - gam user ~primaryEmail empty drivetrash 
 

Again, replace “exam.school.ca” with whatever’s appropriate for your environment. 
 

Some schools use these exam accounts on a regular basis - not just for provincial assessments.  So they needed to find a 
solution that could be used by teachers daily, and would not require constant updates, PW resets, changes, etc.  That’s where 
GAM comes in. 
 
To be compliant with Ab Ed’s new directive to backup all provincial assessments for AT LEAST 30 days, we needed to find an 
efficient solution that did not require the students to do anything.   
 

STEP 6: Add a Custom App to block the Research Pane 
The research pane in Google Docs must be blocked as it allows students to retrieve information from the internet (see 
screenshot below). Chinook’s Edge School Division has created and published a Chrome Extension that “hides” the research 
pane.  Essentially, the extension covers the research pane area which also means the “Define” menu will also be covered (and 
inaccessible).  It is recommended that a dictionary extension be installed to address this issue. 

The Hide Google Docs Research extension is publicly available at no cost to all school authorities who want to employ the use 
of Google Docs to administer their Diploma Exams on Chrome OS devices. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Install the Chrome extension using one of the two methods listed below: 

• Search through the Chrome web store (top left option) 

• Specify the custom (bottom left option) using the credentials below: 

https://github.com/jay0lee/GAM/wiki
https://chrome.google.com/webstore/detail/hide-google-docs-research/fnifdkggkcjiaahokngjoajgpboaaojb?hl=en
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ID: fnifdkggkcjiaahokngjoajgpboaaojb 

URL: https://chrome.google.com/webstore/detail/hide-research/fnifdkggkcjiaahokngjoajgpboaaojb 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

Contact Alberta Education 
 

Jennifer Phillips   
Online Assessment Specialist 
780-415-0824  

Jeremy Wiebe 
Manager, Online Exam Administration 
780-641-8987 

 

https://chrome.google.com/webstore/detail/hide-research/fnifdkggkcjiaahokngjoajgpboaaojb
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